Financial Management Reporting

Training for College and School Administrators
Background

As part of the change to the new structures, the Finance Office set up a project entitled “Financial Management Reporting”.  The objectives of this project was to:

· Provide financial management reports under the new structure.

· Empower Colleges and Schools by allowing the running of reports within these units.  This allows for real time financial information for all Colleges and Schools.

· Meet end-user reporting needs by getting feedback from working group and a sample of end-users.

· Provide training to College and School administrators.

The project approach was as follows:

· Identify user groups.

· Design reports.

· Develop reports.

· Distribute reports for feedback.

· Test Reports.

· Implementation and training.

A presentation explaining the project was made to the College Transition Coordinators Group on the 8th July 2005.  It was agreed at this presentation that the Transition Coordinators would nominate a person responsible for the running and distribution of reports within each College and School.  It was explained that nominees would run and distribute all monthly reports to managers for all cost centres, D accounts, Research accounts and other project accounts under that unit.  

Overview

· A standard suite of Business Objects reports has been designed which will address the reporting requirements of each College and School.

· Reports will be available on a real time basis to Colleges and Schools.

· A standard suite of reports will be kept in a central repository for general access.

· Additional reporting that may be required can be requested by emailing Financial.Information@ucd.ie

Responsibilities of College/School Nominees

· Contact point for all managers of cost centres/D accounts and research accounts within the unit.

· Running and distribution of financial reports (Monthly and once off requests)

· Maintain distribution list for the unit.

How to access Business Objects Reader
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Business Objects can be accessed on a PC through NAL (Novell Delivered Applications).  The icon is located in the Business Objects folder, within the Administration folder. Double click on the Reader v5.1.2 icon to open the application - Diagram 1.

Diagram 1 : Business Objects Access through NAL
· The Business Objects login dialogue box will appear - Diagram 2. Enter your Business Objects User Name and Password and click OK. The syntax for User Names is most commonly first initial last name (i.e. jbloggs). 

· Remember when logging on that Business Objects is case sensitive – and that your User Name and Password has been specified in lower case – so ensure that your Caps Lock key is off. Once the correct User Name and Password have been entered, you will be within Business Objects Reader and are ready to run a report. 
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Diagram 2 : Business Objects Login Dialogue Box

· If you enter an incorrect User Name or misspell your User Name, you will be presented with the following dialogue box - Diagram 3. Click on the OK button and try again.
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Diagram 3 : Business Objects Incorrect User Name Dialogue Box 

· Business Objects allows you three attempts to enter the correct Password. If you enter an incorrect Password or misspell your Password, you will be presented with the following dialogue box - Diagram 4. Click on the OK button and try again. After the third attempt of entering the wrong Password, Business Objects disables your account, preventing you from logging in. If this happens, you need to contact Eileen Penston, Bursar's Office (tel. 1484) to have your account re-enabled and your Password reset.
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Diagram 4: Business Objects Incorrect Password Dialogue Box 

How to Run a Business Objects Report

· The Business Objects Reader Workspace is shown below - Diagram 5. It is composed of three parts: Menu and Toolbars, Report Manager Window and Report Window.
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Diagram 5: Business Objects Reader Workspace
· The Menus and Toolbars contain all the commands for the tasks you need to carry out in Business Objects Reader.

· The Report Window displays the report data. When you click on a report in the Report Manager, the selected report is displayed in the Report Window.

· To open a report, click on the Open File icon - Diagram 6.

Diagram 6: Business Objects open file icon [image: image9.png]



· Select the report you want to open and double click on it. Note that all Business Objects reports have a .rep extension.  (Note: It is intended that all reports will be retrieved from a Repository)

· The report will open up in Business Objects and the results from the last time it was run will be displayed. If the report was saved without data then only headings and empty columns will be displayed. 

· To refresh or re-run the report with your own specific criteria, click on the Refresh button - Item f in Diagram 7 below.
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Diagram 7: Standard Business Objects Reader Toolbar 

· A dialogue box prompting for certain values will appear - Diagram 8.

· Specify your parameters in the dialogue box and Click OK. 
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Diagram 8: Sample Dialogue Box with Prompts 

HELP ON WHAT TO ENTER IN PARAMETERS

· Account Structure in all cases is A

· Cost Centre Structure is now R

· Depending on the report being run you will be asked to insert your Cost Centre Code, your School Code or your College Code – Details will be supplied to each school.

· The date to begin is entered in the format 01/10/2005 and will depend on the dates for which data is required – usually one month.

· The date to end is entered in the format 31/10/2005 

· Depending on the report being run you may be prompted for the year this is the current financial year. Which starts with October each year ie October 2005 it actually in the financial year 2006.

· You may also be prompted for the period – this must coincide with the end date.  I.e: for 31/10/05 the period is 01

· When running reports for Research or Other funds your will be prompted for a Job code and a Job Structure.  The code will be your Rxxx or Dxxx code and the Structure will again be R

· When all fields are completed select the run button and your report will be produced – depending on the report and the dates selected this might take a few minutes.

· If you are not exactly familiar with the codes you want to use then it is best to click the Values button on each prompt field. This will provide you with a List of Values from which to select. 

· Once all parameters are specified click OK and Business Objects will commence processing the report. You will know the report is processing by the status bar at the bottom of the window which will move from “Analysing” to “Time” to “Rows”

· To print any Business Objects report you have produced just click the Print button - Item C in Diagram 8 or choose File – Print from the Menu bar. You may be prompted to select a printer depending on your set up when OK is hit the report will spool for printing.

· When finished with the report close it, you will be asked do you want to save changes. Click NO.  

· The report will remain in the repository to be used by someone else or whenever you require it again.
Retrieving Reports Through Business Objects

The Business Objects application allows reports to be sent to and retrieved by users very easily. The process of retrieving reports that have been sent to you via Business Objects is outlined below.

· Open Business Objects Reader through NAL and enter your Username/Password.

· If you have been sent Business Objects Report(s) you will see a message as Diagram below:
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Diagram 9 : Business Objects Notification of Sent Reports Dialogue Box
· To retrieve report(s), go to File / Retrieve From / Users. A dialogue box should appear showing Business Objects Reports that have been sent to you and have yet to be retrieved.
· Click on the document name and hit the Retrieve button

· This will automatically import the Business Objects Report into your standard Business Objects user document directory. As stated earlier this is generally H:\BusinessObjects. 

· To open and run your retrieved report, go to File / Open and locate the report you have recently retrieved.

· Go to the menu and choose Data / Refresh Data or click on the icon below.
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Exporting Business Objects report data to Excel

The steps below highlight how to export raw data from a Business Objects Report into Microsoft Excel where it can be manipulated as the user wishes. The raw data is exported from Business Objects as a text file and can be opened in any data manipulation package. We have used Excel in our example below, as it is the most commonly used spreadsheet package in UCD.

· Open Business Objects.

· Open and refresh the relevant Business Objects Report.

· Click on the Edit Menu and choose Copy All.  

· Open up Microsoft Excel.   A new blank worksheet should appear.

· Highlight the column in the blank worksheet into which the student number data will be pasted.  Click on the Format menu and choose Cells.  Change the format of this column to Text.

· Place the cursor in cell A1 of the blank Excel worksheet.  Click on the Edit menu and choose Paste.  The data from the Business Objects report will appear in the worksheet.

· This is raw data and does not include formatting that was on the Business Objects Report. This raw data can be manipulated as you wish (e.g. deletion of headings, creation of additional columns to compute overall marks totals etc.)

· Save the worksheet as an Excel file.

Advice on saving Business Objects Reports

To minimise the space taken up on your H drive by Business Objects reports, it is recommended that you do not save the reports when closing them.  This means that each time you open a report it will appear with no data in it, and you will have to refresh the data.

If you accidentally save a report with data in it and you wish to remove the data, click on the View Data icon below or go to the menu and choose Data / View Data.
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The Data Manager dialog box will appear.  Click on the Purge button to remove the data.  

Business Objects Reports Available

College Reports

· Fin 035a College year to date variance report 

· Fin 197a Research Summary by Manager/School for entire College (M)

· Pay reports to be supplied to College

· All reports below

School Reports

· Fin 001b Cost Centre detail report for an individual cost centre.

· Fin 001d Cost Centre detail report for all cost centres in School.  (M)

· Fin 011a Cost Centre summary report for an individual cost centre.

· Fin 009 Cost Centre summary report for all cost centres in School.  (M)

· Fin 019a Summary report of School position at point in time.

Project Reports

· Fin 023 Project detail report for an individual project.

· Fin 024a Project detail report for all projects assigned to an individual manager.

· Fin 026a Project detail report for all projects in a School (M)

· Fin 027 Project summary report for an individual project.

· Fin 029b Project summary report for all projects assigned to an individual manager.

· Fin 029a Project summary report for all projects in a School. (M)

· Fin 197 Research summary for School.

· Fin 194b Labels for all Project accounts in Schools

Running reports

Frequently Asked Questions
Colleges and Schools
· What is a Cost Centre Code? 

This is a bottom level four-digit numeric posting code assigned to you. It is described as a level 9 Cost Centre Code.

· What is a School Code? 

This is a code assigned to a School that has more than one cost centre in the reporting structure. It is a four digit alphanumeric code made up of S and three numeric digits Eg. S001. It is described as a Level 6 Cost Centre Code.

· What is a College Code? 

This code is assigned to a College for reporting purposes so we can group all the schools within that college. It is an alpha code made up of two letters.  It is described as a Level 3 Cost Centre Code.

· How do I find my College, School or Cost Centre Code? 

Central Finance keeps a database of all Codes on the System. The Dean, College Administrator, School Administrator or Head of School can request details of their codes. Alternatively by referring to recently printed reports from the Bursar’s Office that show the relevant codes at the top of the first page.

· My report requests a Cost Centre Structure 

Cost Centre Structures for the purpose of reporting is always: R

· My Report requests a Account Code Structure 

Account Code Structure for the purpose of reporting is always: A

· What start date and end date should I enter? 

School Budgets run from the start of our academic year from 01/10/xxxx to 30/09/xxxx i.e. starts October 2004 and ends September 2005. For interim periods use that month end date.

· My report requests a Period 

The period is the months in our academic year. For example October is the start of our academic year and the period is always 01 while September is the end of our academic year and the period is 12. Interim periods follow i.e. January is period 04. Note: for easy reference most reports have been modified to ask for start and end dates.

· My reports requests a Year 

The year for reporting purposes is always the year in which our academic year ends. For Example to run a report in October 2004 the parameters to enter is period 01 and year 2005.

Research and School Funds
· What is a Job Code? 

This is a bottom level alpha numeric posting code that usual begins with a letter followed by four numeric numbers. This code is assigned when a request is sent to the Office of Funded Research for a new research project or Finance Office for capital fund projects. It is usually described for reporting purposes as a Level 9 Job Code.

· What is a Manager Number? 

All projects are assigned to a manager whihch will be either Head of School or Principle Investigator and in the case of research manager may have more than one fund.. The Manager Number is used to report on all jobs held by a particular manager in a School. It is usually described as a Level 8 Job Code and is a four digit numeric code.

· How do I find my Job Code or Manager Number? 

Central Finance keeps a database of all Codes on the System. The Principle Investigator can request details of their Job codes or Manager Numbers. Alternatively by referring to recently received reports by the Bursar’s Office that show the relevant codes at the top of the first page.

· My report requests a Cost Centre Structure 

Cost Centre Structures for the purpose of reporting is always: R

· My Report requests a Job Structure 

Job Structure for the purpose of reporting is always: R

· What start date and end date should I enter? 

Research & Departmental Fund Budgets run from the start date of when the project was originally set up on the system. Efinancials was installed in October 1997 so any projects with a start date prior to this should enter 01/01/1997 as all transactions were carried over.

· My report requests a Period 

The period is the months in our academic year. For example October is the start of our academic year and the period is always 01 while September is the end of our academic year and the period is 12. Interim periods follow i.e. January is period 04. Note: for easy reference most reports have been modified to ask for start and end dates.

· My reports requests a Year 

The year for reporting purposes is always the year in which our academic year ends. For example to run a report in October 2004 the parameters to enter is period 01 and year 2005.
Corporate Information Website Overview.

The Corporate Information Project is a university-wide project sponsored by the Registrar Dr Philip Nolan with the support of the Bursar and the Vice President for Staff Affairs & Administrative Systems.

The long-term goal of the Corporate Information project is to develop UCD’s corporate information environment, with a view to ensuring the consistent and transparent dissemination of information from administrative systems, both internally and externally. For the first time, this project brings together information relating to service from the three major administrative systems (Banner Student Information System, CORE HR/Payroll System, and the eFinancials System).

This site features a link to the Corporate Information Catalogue, which is an index of sources of management information around the university. It also details the current policy with regard to rollout of administrative systems, and provides information for users of administrative systems on how to get access to them and how to use them. Finally, it provides statistics on requests for service from the administrative systems.

We encourage feedback and comment from users of this site on how it can be made more useful. Please email corporate.information@ucd.ie with your comments.
Corporate Information - E-financials. 
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· Management and development of the Cedar eFinancials System. 

· Deployment of eFinancials (including Accounts Receivable and Purchase Order Processing) university-wide. 

· Delivery of Business Objects reports from eFinancials to academic and support units, and to research project managers. 

· System security and integrity. 

· Functional system testing, configuration and data modelling. 

· Provision of a 'Help Desk' function for users to provide non technical support.
Utilising the Corporate Information Website.

The Corporate Information website is a catalogue of reports that are available to end-users.  All reports that are available to the Colleges and Schools will be included in the Corporate Information catalogue.
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